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ABSTRACT 

 
The Design, Construction, and Performance Study of an Arduino-based Solar Home 

System (SHS) present a comprehensive exploration of a renewable energy solution for 

residential applications. Employing an Arduino Nano micro-controller as the central 

control unit, the system integrates key components, including a solar panel, battery, solar 

charge controller, inverter, relay, lights, and fans. The project's objectives encompass the 

entire life cycle of the SHS, from design and construction to a detailed performance study. 

The system design involves creating a schematic diagram to elucidate the intricate 

connections between components, accompanied by specifications and requirements for 

each element. The Arduino Nano is programmed to orchestrate the solar charge controller, 

monitor battery status, and regulate power distribution to lights and fans, incorporating 

safety features against overcharge and over-discharge. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 Introduction 

In an era marked by growing environmental consciousness and the pursuit of 

sustainable energy alternatives, the Solar Home System (SHS) emerges as a pioneering 

solution to address residential energy needs. Recognizing the potential of solar power 

to offer a clean and renewable energy source, this project integrates a range of 

components, including a solar panel, solar charge controller, battery, inverter, relay, and 

energy-efficient appliances. Central to the system's operation is the Arduino Nano 

micro-controller, providing intelligent control and monitoring capabilities. 

 

The increasing demand for reliable and eco-friendly energy solutions necessitates the 

exploration of decentralized power generation. Solar energy, abundant and 

environmentally benign, offers a compelling avenue for meeting this demand. The SHS 

not only capitalizes on solar energy but also integrates advanced control mechanisms 

through the Arduino Nano, enhancing its efficiency, adaptability, and user-friendliness. 

 

This project seeks to address the challenges associated with traditional power sources 

by providing an accessible and sustainable alternative for residential energy needs. The 

integration of the Arduino Nano allows for dynamic control over the solar components 

and connected appliances, enabling optimized energy utilization and real-time 

monitoring. Additionally, the SHS promotes energy independence by harnessing the 

sun's power, reducing reliance on conventional grid systems and minimizing the carbon 

footprint associated with electricity consumption. 

 

The following sections of this paper delve into the detailed design and construction of 

the Solar Home System, emphasizing the integration of each component and the 

programming intricacies of the Arduino Nano. The subsequent performance study 

evaluates the system's efficiency, reliability, and user interface, thereby contributing to 

the growing body of knowledge on sustainable energy solutions for residential 

applications. The Solar Home System represents a significant step towards fostering a 

greener and more resilient future for domestic energy consumption. 
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1.2 Background Study 

Solar energy stands out as a promising renewable resource with vast potential. Solar 

power systems convert sunlight into electricity, offering a sustainable and eco-friendly 

solution. Harnessing this energy source becomes imperative in mitigating climate 

change and ensuring energy security. Centralized power generation and distribution 

systems face challenges like transmission losses and vulnerability to natural disasters. 

Decentralized systems, such as solar home systems, provide localized power generation, 

enhancing energy resilience and reducing reliance on large-scale infrastructure. Energy 

efficiency is a critical aspect of sustainable energy systems. Efficient energy 

management not only reduces waste but also ensures optimal utilization of available 

resources, making solar power systems more economically viable and environmentally 

friendly. 

 
1.3 Objectives 

The objectives of this project are: 

 
⚫ To study of an Design Construction and Performance Study of a Solar 

Home System. 

⚫ To design and implement Automatic System. 

⚫ To implement a system for easy to our daily life. 

⚫ To take necessary notes from the project for future improvements. 

 
 

1.4 Organization Of The Book 

 

• Chapter 1: Introduction. This chapter is all about background study, air 

purifier, use or air purifier, Objectives and thesis book organization. 

 

• Chapter 2: Literature Review- Here briefly describe about air purifier 

technology, filter availability, previous book review, Block diagram, Structural 

Diagram, Components List and Summary of this chapter. 

 

• Chapter 3: Hardware Analysis- This chapter is discussed about our project 

hardware . Here we describe our hole instrument details. 
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• Chapter 4: Methodology– Here briefly discuss about project methodology, 

hardware parts, our system working mechanism, project final image, working 

principle and our system overview. 

 

• Chapter 5: Results and Discussion– Here briefly discuss about project 

discussion, result analysis, advantages, disadvantages, application and our 

system overview. 

 

• Chapter 6: Conclusion – This chapter is all about our thesis future 

recommendation and this project conclusion. 
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1 Introduction 

In this chapter we will discuss some literature review. Here are some of the ideas we 

got after this project related literature. 

 
2.2 Literature Review 

A number of related studies and projects were found in the area of home automation 

systems as follows: The goal of this study was to control the home automation system 

remotely using Wi-Fi technology. One of the main objectives was to implement an 

inexpensive and open source home automation system. Problems and challenges facing 

the home automation system had included: poor security and high cost [5]. The 

purpose of this paper was to provide a home automation system on the cloud at a low 

cost and use the least cost resources possible. 

 
One of the reasons that led to this work was due to the fact that home automation 

systems were currently expensive in terms of maintenance and installation [6]. This 

study focuses on various security flaws in existing home automation systems. The 

concept of security is defined and the challenges in home security from the home 

owner and security engineer perspective are addressed. It discusses why automated 

operating systems are attractive targets for an attacker [7]. This study raises awareness 

of the use and misuse of information for homes, and end users. The study noted the 

requirement for a more general security and privacy model at the design stage. 

 
In the risk analysis stage, the intelligent home automation system was separated into 

several parts: hardware, software, communication and human information. A total of 32 

risk tests were examined, with most risks being rated as medium risk. A number of risks 

were classified as high as they are related to human factors/errors or software 

components [8]. A proposed system checks for various problems related to the 

development of a home automation interface as well as using existing system solutions 

to solve problems. Data analysis was used to collect qualitative data from research and 

results were collected from the use of open coding [9]. 
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The aim of this study is to produce a product that would allow people to connect with 

their home appliances using Wi-Fi, and develop an initial product that allows the user 

to know whether the door is open or closed. The work focused on using low cost and 

open source software [10]. This paper describes a home automation system that 

supports connectivity between mobile devices, and cloud networks, via wireless 

communications. The aim was to provide users with a remote interface to control 

various elements within their home [11]. This paper describes an implementation and 

design of a smart home control system. The smart home system and subsystems are 

controlled remotely using the Internet with LABVIEW software [12]. In this study, IP 

addresses are used to access and control remote devices. This study does not require a 

dedicated server, however, provides a communication protocol for monitoring and 

controlling the home environment. 

 
Remote device control is achieved using voice and speech recognition through a Google 

service, which eliminates the need for an external audio recognition module [13]. In this 

study, an electrical monitoring device and remote home and office control system are 

designed using a GSM modem. Users can monitor and control devices by sending SMS 

messages. The study could be extended to use Wi-Fi communication and audio control 

using an Android or PC based application [14]. 

 
Lack of access to electricity is a major constraint on growth and development in Third 

World rural areas. A large number of rural settlements are still without access to 

electricity, especially in sub-Saharan Africa and developing Asian countries. Due to 

high transmission and distribution costs in remote areas, many households are not 

connected to the national electricity network. For example, in rural areas of Bangladesh, 

where more than 70% of the population lives, only 42% have access to the (unreliable) 

electricity supply 

 
Global electricity generation depends mainly on depleting fossil fuel sources followed 

by nuclear, hydro, and other renewable sources (e.g., wind, solar, tidal wave, and geo- 

thermal energy). Pollution emitted by coal and natural gas plants is linked to several 

types of health and environmental hazards [5,6]. Moreover, CO2 emissions contribute 

to global warming and climate change (IPCC). Renewable energy is extremely 

important to ensure future energy security, stability, and prosperity. 

https://www.mdpi.com/1996-1073/10/10/1615
https://www.mdpi.com/1996-1073/10/10/1615
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2.3 Block Diagram 

In our project we have set up an Design Construction and Performance Study of a 

Solar Home System. In this diagram we will show by block the individual parts. 

 

Figure 2.1: Block Diagram of of our system 

 
2.4 Schematic Diagram 

The schematic diagram here is representing the electrical circuit and the components of 

the Design Construction and Performance Study of a Solar Home. Here we connect 

equipment with he smart wire connection. 

 

 

Figure 2.2: Schematic Diagram of our circuit 
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2.5 Components List: 

 
Hardware Part: 

 
1. Arduino Nano 

2. Solar Panel 

3. Battery 

4. Solar Charge Controller 

5. Inverter 

6. LCD Display 

7. Voltage Regulator 

8. Light 

9. Fan 

 

Software Part : 

 

1. Arduino IDE Software 

2. Easy EDA Software 

 

2.6 Summary 

The above discussion gives an idea about the Design Construction and Performance 

Study of a Solar Home. All that work on this system already been done here, and the 

results of their work, the use of Design Construction and Performance Study of a Solar 

Home in the situation are described in detail. From this we also got the direction of 

work of the project. 
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CHAPTER 3 

HARDWARE ANALYSIS 

 
3.1 Arduino Nano 

Arduino is an open source electronics prototyping platform based on flexible, easy-to- 

use hardware and software. It's intended for artists, designers, hobbyists, and anyone 

interested in creating interactive objects or environments. Arduino can sense the 

environment by receiving input from a variety of sensors and can affect its 

surroundings by controlling Lights, motors, and other actuators. 

 
 

 

Figure 3.1: Arduino Nano 

 
The micro controller on the board is programmed using the Arduino programming 

language (based on Wiring) and the Arduino development environment (based on 

Processing). Arduino projects can be stand-alone or they can communicate with 

software on running on a computer (e.g. Flash, Processing, Maxims’). 

 

 

Figure 3.2: Arduino Nano Schematic Diagram 
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Arduino Nano is a surface mount breadboard embedded version with integrated USB. It 

is a small, complete, and breadboard friendly component. It has everything that 

Decimal/ Duemilanove has (electrically) with more analog input pins and onboard +5V 

AREF jumper. Physically, it is missing power jack. The Nano can automatically sense 

and switch to the higher potential source of power. Nano’s got the breadboard-ability of 

the Boarding and the Minibus with smaller footprint than either, so users have more 

breadboard space. It’s got a pin layout that works well with the Mini or the Basic Stamp 

(TX, RX, ATN, and GND on one top, power and ground on the other). 

 

 
Figure 3.3: How Arduino Nano looks like 

 
Specifications 

 
⚫ Micro controller: Atmel ATmega328 

⚫ Operating Voltage (logic level): 5 V 

⚫ Input Voltage (recommended): 7-12 V 

⚫ Input Voltage (limits): 6-20 V 

⚫ Digital I/O Pins: 14 (of which 6 provide PWM output) 

⚫ Analog Input Pins: 8 

⚫ DC Current per I/O Pin: 40 mA 

⚫ Flash Memory: 32 KB (of which 2KB used by boot loader) 

⚫ SRAM : 2 KB 

⚫ EEPROM: 1 KB 

⚫ Clock Speed: 16 MHz 

⚫ Dimensions: 0.70” x 1.70” 
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Micro controller IC ATmega328p 
 

 
Figure 3.4: Micro controller IC AT mega 328p 

 

 

Features: 

 

• Automatic reset during program download 

• Power OK blue LED 

• Green (TX), red (RX) and orange (L) LED 

• Auto sensing/switching power input 

• Small mini-B USB for programming and serial monitor 

• ICSP header for direct program download 

• Standard 0.1 spacing DIP (breadboard friendly) 

• Manual reset switch 

 

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro-controller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 

2KB SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three 

flexible timer/counters with compare modes, internal and external interrupts, serial 

programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6- 

channel 10-bit A/D converter (8-channels in TQFP and QFN/MLF packages), 

programmable watchdog timer with internal oscillator, and five software selectable 

power saving modes. The device operates between 1.8-5.5 volts. By executing powerful 

instructions in a single clock cycle, the device achieves throughputs approaching 1 

MIPS per MHz, balancing power consumption and processing speed. 
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3.2 AC Exhaust Fan 

Exhaust fans are used to pull excess moisture and unwanted odors out of a 

particular room or area. They are commonly found in bathrooms and kitchens, where 

moisture can build up due to activities such as showering, washing, or cooking. The 

existence of clean air in the house is something that every homeowner must pay 

attention to. As is known, dirty air trapped in the house can cause various diseases, 

especially respiratory diseases for all family members. Because of that, every house 

must have a good air circulation system by installing ventilation. As for people who live 

in urban areas, often the presence of ventilation is not enough to replace the air in the 

house. 

 

 

Figure 3.5: AC Exhaust Fan 

 
Exhaust fans are a solution so that the exchange of clean air and dirty air in the house 

can run well. Sometimes homeowners can install more than 1 exhaust fan in the house. 

Usually the rooms where the exhaust fan is installed are the bathroom and kitchen or 

places with poor air circulation. There are various types of exhaust fans available in the 

market. Just adjust it to the needs and benefits you want to get. Even so, it turns out that 

the exhaust fan has its own advantages and disadvantages. 

 
Exhaust Fan Advantages 

The existence of an exhaust fan provides many advantages, especially if it is installed 

in a room with poor air circulation. The advantages of exhaust fans include: 

https://yaletools.com/types-of-exhaust-fan/
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1. Improve Indoor Air Quality 

Exhaust fans installed in rooms such as bathrooms or kitchens can help improve air 

quality to be cleaner. Stuffy air like in the bathroom to the smell of cooking that is too 

strong can be replaced immediately if there is an exhaust fan in the room 

 
2. Eliminate Bad Smell 

The unpleasant and pungent smell is very disturbing. Especially if the aroma comes 

from a room with a poor air exchange system such as in the bathroom. This makes 

people think that the room is very dirty and makes people reluctant to enter it. For this 

reason, the installation of an exhaust fan is necessary to reduce or eliminate unpleasant 

odors in the room. That way the air in the room remains clean and does not smell when 

entering the room. 

 
3. Removes Air Moisture 

A humid room makes the air stuffy and smelly. If left unchecked, it is not impossible to 

damage the walls and ceiling of the house because it is too wet. Even in certain parts 

can be overgrown with moss and fungus which of course can damage a room. For this 

reason, the installation of an exhaust fan is very useful to quickly remove moisture 

from the air. That way the air in the room remains dry and not too humid because of 

good air exchange by the exhaust fan. Installing an exhaust fan in the bathroom can 

also help eliminate foggy mirror syndrome due to too high humidity. 

 
4. Reduce Air Contamination 

Cooking smoke, cigarette smoke, hot air, and unpleasant odors are very disturbing to 

the human respiratory system. Especially if the air is dangerous and causes a disease if 

inhaled for a long time. For this reason, the existence of clean air must always be 

available in the house in order to provide comfort for every family member. Removing 

contaminated and dirty air does not need to open all windows and doors of the house, 

just use an exhaust fan. Because the change of air becomes faster and easier if you use 

an exhaust fan. 
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5. Can Be Used as an Air Conditioner 

Exhaust fans can also cool the air in the room. This is in accordance with the working 

principle of the exhaust fan, which is to absorb hot air in the room to the outside, then 

replace it with new air so that the room becomes cooler. 

 
At first glance, the way it works is similar to a fan, but it is more efficient at dissipating 

heat in the room. 

 
Disadvantages of Exhaust Fan 

Behind the advantages, it turns out that the exhaust fan also has several disadvantages, 

including: 

 
• Almost all exhaust fans sold on the market use electricity in the form of 

electricity, so that in the event of a power outage, of course the exhaust fan 

cannot work. 

 

• Some types of exhaust fans must be installed in the wall or even become one 

with the ceiling of the house or ceiling. In other words, the exhaust fan 

cannot be moved anywhere. 

 

• If the installation is not done properly, there is a possibility that hot and 

humid air can escape to other areas in the house. Not only that, an exhaust 

fan that is not properly insulated, when air is drawn from the interior, can be 

lost in the attic of the house and can actually cause another problem such as 

damp tiles. 

 

• Improper installation of the exhaust fan can make a noise when the fan 

rotates. The sound produced is very disturbing to the occupants of the house, 

so it is very likely that the exhaust fan will not be operated. 

 

• Exhaust fans are only used to remove air from inside to outside the room or 

in one direction. 
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Application 

Exhaust fans cool down the indoor spaces, ventilate the hot and stuffy air, and can 

prevent the excess amount of moisture content effectively from building u in the damp 

areas. 

 
3.3 Solar Panel 

A solar panel is a set of solar photovoltaic modules that are electrically connected and 

mounted on a support structure. A photovoltaic module is a packaged, connected assembly 

of solar cells. The solar panel can be used as a component of large photovoltaic systems 

for power generation and supply in commercial and residential applications. Each module 

is rated by DC output power under Standard Test Conditions (STC) and typically ranges 

from 100 to 320 watts. The efficiency of the module determines the area of the given 

module with the same rated output - an 8% efficient 230 watt module will be twice the 

area of a 16% efficient 230 watt module. A single solar module can produce only a limited 

amount of energy; Most organizations have more than one module. A photovoltaic system 

usually consists of an array of panels or solar modules, an inverter and sometimes a 

battery and / or solar tracker and interconnection wires. 

 

 

Figure 3.6: Solar Panel 

 
Solar cell modules only generate electricity when the sun is shining. They do not store 

energy, so to ensure the flow of electricity when the sun is not burning, some of the 

energy produced needs to be stored. The most obvious solution is to use batteries, which 
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chemically store electrical energy. Batteries are connected in series with a group of 

electrochemical cells (devices that convert chemical energy into electrical energy). The 

battery cells have two electrodes immersed in the electrolyte solution which creates an 

electric current when a circuit is formed between them. The current is the result of 

opposite chemical reactions between the electrode and the electrolyte in the cell. 

Rechargeable batteries are called secondary or rechargeable batteries. As the battery is 

charged, electrical energy is stored in the cells as chemical energy. During discharge, the 

stored chemical energy is removed from the battery and converted into electrical energy. 

Lead-acid batteries are the most common type of battery in East Africa. 

 
3.4 Solar Charge Controller 

 

Figure 3.7: Solar Charge Controller 
 
 

Figure 3.8: Solar Sell System Curve 
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Here is a solar charger circuit that uses solar energy to charge lead acid or non-CD 

batteries. The circuit produces solar energy to charge a 6.5 4.5 rechargeable battery of 

6 volts for various applications. The charger has voltage and current control and over 

voltage cut-off facility. 

 

 

Figure 3.9: Solar Charger Controller Circuit 

 
The circuit uses a 12 volt solar panel and a variable voltage regulator IC LM317. A 12 

volt DC is available from the panel to charge the battery. Output voltage and current 

can be controlled by adjusting its adjusting pin when the current is charged via D1 in 

voltage regulator IC LM317. Adjustments are placed between the pin and ground to 

supply an output voltage of 9 volts to the VRT battery. 

 
The resistor R3 limits the charging current and the diode D2 prevents the discharge of 

current from the battery. Transistor T1 and Zener diode ZD act as cutoff switches when 

the battery is full. Usually the T1 stays off and the battery current is charged. When the 

terminal voltage of the battery rises above 6.8 volts, the base current is supplied to the 

Zener T1. It then turns on the output grounding of the LM317 to stop charging. 

 
3.5 Battery 

A battery is a device consisting of one or more electrochemical cells with external 

connections for powering electrical devices such as flashlights, mobile phones, and 

electric cars. When a battery is supplying electric power, its positive terminal is the 

cathode and its negative terminal is the anode. 
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Figure 3.10: Battery 

 

Product Specification 
 

Table 01: Battery Specification 

Capacity 4.5 

 
Battery Type Acid Lead Battery 

Brand  Super Shell 

Nominal Voltage 6 Volt 

 
Capacity (Ah) 4.5 AH 

 
Warranty 6 month 

 
Weight 0.750 kg 

 
Usage/ Application UPS, Automobile, Inverter, Solar, Industrial 

 

 

 
3.6 Inverter 

A power inverter, inverter or invertor is a power electronic device or circuitry that 

changes direct current (DC) to alternating current (AC).[1] The resulting AC frequency 

obtained depends on the particular device employed. Inverters do the opposite 

https://en.wikipedia.org/wiki/Power_electronics
https://en.wikipedia.org/wiki/Direct_current
https://en.wikipedia.org/wiki/Alternating_current
https://en.wikipedia.org/wiki/Power_inverter
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of rectifiers which were originally large electromechanical devices converting AC to 

DC.[2] The input voltage, output voltage and frequency, and overall power handling 

depend on the design of the specific device or circuitry. The inverter does not produce 

any power; the power is provided by the DC source. 

 
A power inverter can be entirely electronic or maybe a combination of mechanical 

effects (such as a rotary apparatus) and electronic circuitry. Static inverters do not use 

moving parts in the conversion process. Power inverters are primarily used in electrical 

power applications where high currents and voltages are present; circuits that perform 

the same function for electronic signals, which usually have very low currents and 

voltages, are called oscillators. Circuits that perform the opposite function, converting 

AC to DC, are called rectifiers. 

 

 
Fig 3.11: Inverter 

 
Input voltage 

A typical power inverter device or circuit requires a stable DC power source capable 

of supplying enough current for the intended power demands of the system. The input 

voltage depends on the design and purpose of the inverter. Examples include: 12 V DC, 

for smaller consumer and commercial inverters that typically run from a rechargeable 

12 V lead acid battery or automotive electrical outlet.24, 36 and 48 V DC, which are 

common standards for home energy systems. 200 to 400 V DC, when power is from 

photovoltaic solar panels. 300 to 450 V DC, when power is from electric vehicle 

battery packs in vehicle-to-grid systems. Hundreds of thousands of volts, where the 

inverter is part of a high-voltage direct current power transmission system. 

https://en.wikipedia.org/wiki/Rectifier
https://en.wikipedia.org/wiki/Power_inverter
https://en.wikipedia.org/wiki/Voltage
https://en.wikipedia.org/wiki/Electrical_power
https://en.wikipedia.org/wiki/Electronic_oscillator
https://en.wikipedia.org/wiki/Rectifier
https://en.wikipedia.org/wiki/High-voltage_direct_current
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3.7 Voltage Regulator 

Voltage sources in a circuit may have fluctuations resulting in not providing fixed 

voltage outputs. A voltage regulator IC maintains the output voltage at a constant value. 

7805 IC, a member of 78xx series of fixed linear voltage regulators used to maintain 

such fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx 

indicates the output voltage it provides. 7805 IC provides +5 volts regulated power 

supply with provisions to add a heat sink. 

 
7805 IC Rating 

⚫ Input voltage range 7V- 35V 

⚫ Current rating Ic = 1A 

⚫ Output voltage range VMax=5.2V ,VMin=4.8V 
 

 

 
 

Figure 3.12: 5V Regulator IC 

 
 

3.8 Arduino IDE 

The digital micro-controller unit named as Arduino Nano can be programmed with the 

Arduino software IDE. There is no any requirement for installing other software rather 

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to 

the micro-controller on our board). The IC used named as ATmega328 on the Arduino 

Nano comes pre burned with a boot loader that allows us to upload new code to it 

without the use of an external hardware programmer. 
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Communication is using the original STK500 protocol (reference, C header files). We 

can also bypass the boot loader and programs the micro-controller through the ICSP (In 

Circuit Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 

boards) firmware source code is available. The ATmega16U2/8U2 is loaded with a 

DFU boot loader, which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map 

of Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that 

pulling the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode. 

 
The Arduino Nano is one of the latest digital micro-controller units and has a number 

of facilities for communicating with a computer, another Arduino, or other micro- 

controllers. The ATmega328 provides UART TTL at (5V) with serial communication, 

which is available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for 

transmit the data. An ATmega16U2 on the board channels this serial communication 

over USB and appears as a virtual com port to software on the computer. 

 

 

Figure 3.13: Arduino Software Interface IDE 

 
The '16U2 firmware uses the standard USB COM drivers, and no external driver is 

needed. However, on Windows, an .in file is required. The Arduino software includes a 

serial monitor which allows simple textual data to be sent to and from the Arduino 

board. The RX and TX LEDs on the board will flash when data is being transmitted via 
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the USB-to-serial chip and USB connection to the computer (but not for serial 

Communication on pins 0 and 1). A Software Serial library allows for serial 

communication on any of the Nano's digital pins. The ATmega328 also supports I2C 

(TWI) and SPI communication. 

 
The Arduino software includes a Wire library to simplify use of the I2C bus. Arduino 

programs are written in C or C++ and the program code written for Arduino is called 

sketch. The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs, 

and for uploading the programs it uses argued. As the Arduino platform uses Atmel 

micro-controllers, Atmel's development environment, AVR Studio or the newer Atmel 

Studio, may also be used to develop software for the Arduino.The Arduino Integrated 

Development Environment - or Arduino Software (IDE) - contains a text editor for 

writing code, a message area, a text console, a toolbar with buttons for common 

functions and a series of menus. It connects to the Arduino and Genuino hardware to 

upload programs and communicate with them. 

Writing Sketches 

 
Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension .ino. The editor has 

features for cutting/pasting and for searching/replacing text. The message area gives 

feedback while saving and exporting and also displays errors. The console displays text 

output by the Arduino Software (IDE), including complete error messages and other 

information. The bottom righthand corner of the window displays the configured board 

and serial port. The toolbar buttons allow you to verify and upload programs, create, 

open, and save sketches, and open the serial monitor. 

Sketchbook 

 
The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store 

your programs (or sketches). The sketches in your sketchbook can be opened from the 

File > Sketchbook menu or from the Open button on the toolbar. The first time you run 

the Arduino software, it will automatically create a directory for your sketchbook. You 

can view or change the location of the sketchbook location from with the Preferences 

dialog. Beginning with version 1.0, files are saved with a .ino file extension. Previous 

versions use the .pde extension. You may still open .pde named files in version 1.0 and 
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later, the software will automatically rename the extension to .ino. 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its 

own tab). These can be normal Arduino code files (no visible extension), C files (.c 

extension), C++ files (.cpp), or header files (.h). 

Uploading 

 
Before uploading your sketch, you need to select the correct items from the Tools > 

Board and Tools > Port menus. The boards are described below. On the Mac, the serial 

port is probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or 

Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to- 

Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or 

COM4, COM5, COM7, or higher (for a USB board) - to find out, you look for USB 

serial device in the ports section of the Windows Device Manager. On Linux, it should 

be /dev/ttyACMx , /dev/ttyUSBx or similar. 

 

Once you've selected the correct serial port and board, press the upload button in the 

toolbar or select the Upload item from the Sketch menu. Current Arduino boards will 

reset automatically and begin the upload. With older boards (pre-Diecimila) that lack 

auto-reset, you'll need to press the reset button on the board just before starting the 

upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is 

uploaded. The Arduino Software (IDE) will display a message when the upload is 

complete, or show an error. 

Libraries 

 
Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import 

Library menu. This will insert one or more #include statements at the top of the sketch 

and compile the library with your sketch. Because libraries are uploaded to the board 

with your sketch, they increase the amount of space it takes up. If a sketch no longer 

needs a library, simply delete its #include statements from the top of your code. 

Third-Party Hardware 



23  

Support for third-party hardware can be added to the hardware directory of your 

sketchbook directory. Platforms installed there may include board definitions (which 

appear in the board menu), core libraries, bootloaders, and programmer definitions. To 

install, create the hardware directory, then unzip the third-party platform into its own 

sub-directory. (Don't use "arduino" as the sub-directory name or you'll override the 

built-in Arduino platform.) To uninstall, simply delete its directory. 

For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd 

party Hardware specification. 

Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial 

connector. To send data to the board, enter text and click on the "send" button or press 

enter. Choose the baud rate from the drop-down menu that matches the rate passed to 

Serial.begin in your sketch. Note that on Windows, Mac or Linux the board will reset 

(it will rerun your sketch) when you connect with the serial monitor. Please note that 

the Serial Monitor does not process control characters; if your sketch needs a complete 

management of the serial communication with control characters, you can use an 

external terminal program and connect it to the COM port assigned to your Arduino 

board. 

 
3.9 Easy EDA Software 

Easy EDA is a web-based EDA tool suite that enables hardware engineers to design, 

simulate, share-publicly and privately and discuss schematics, simulations and printed 

circuit boards. Other features include the creation of a bill of materials, Gerber files and 

pick and place files and documentary outputs in PDF, PNG and SVG formats. Easy 

EDA allows the creation and editing of schematic diagrams, SPICE simulation of 

mixed analogue and digital circuits and the creation and editing of printed circuit board 

layouts and, optionally, the manufacture of printed circuit boards. 

 
Subscription-free membership is offered for public plus a limited number of private 

projects. The number of private projects can be increased by contributing high quality 

public projects, schematic symbols, and PCB footprints and/or by paying a monthly 

subscription.Registered users can download Gerber files from the tool free of charge; 

https://en.wikipedia.org/wiki/Electronic_design_automation
https://en.wikipedia.org/wiki/Circuit_diagram
https://en.wikipedia.org/wiki/Simulation
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Bill_of_materials
https://en.wikipedia.org/wiki/Gerber_format
https://en.wikipedia.org/wiki/SPICE
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but for a fee, Easy EDA offers a PCB fabrication service. This service is also able to 

accept Gerber file inputs from third party tools. 

 

 

Figure 3.14: Easy EDA Software Interface 
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CHAPTER 4 

METHODOLOGY 

 
4.1 Our methodologies for the project: 

Our methodologies for the project: 

 
 

⚫ Creating an idea for design and construction of an Design Construction and 

Performance Study of a Solar Home System. And designing a block 

diagram & circuit diagram to know which components we need to construct it. 

⚫ Collecting all the components and programming the micro-controller to control 

the whole system. 

⚫ Setting up all the components in a PCB board & then soldering. Lastly, 

assembling all the blocks in a board and to run the system & for checking 

purposes. 

 
4.4 Our Project Final Image 

 

 
Figure 4.1: Our Final System Overview 
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4.5 Working Principle 

The Solar Home System (SHS) operates on the principle of harnessing solar energy 

through photovoltaic technology, storing it in a battery, and intelligently managing the 

distribution of power to meet household energy needs. The Arduino Nano micro- 

controller serves as the brain of the system, coordinating the functionalities of various 

components for efficient and adaptive control. The solar charge controller regulates the 

charging process to prevent overcharging or deep discharging of the battery. The 

charged DC electricity is directed to a rechargeable battery for storage. The DC 

electricity stored in the battery is converted into alternating current (AC) by the inverter. 

The Arduino Nano controls a relay to manage the power supply to connected 

appliances, as lights and fans. 

 
4.6 Cost Analysis 

In the below table we have summarized our project expenditure. 

 
Table 1: Lists of Components with Price. 

 

Sl. 

No 

Product Name Specification Qty. UnitPrice 

(Taka) 

Total Price 

(Taka) 

01. Arduino Nano ATmega328P 1 450 450 

02. Solar Panel 6V 6W 1 580 580 

03. Battery 6V, 4.5A 1 750 750 

04. Inverter 100W 1 200 200 

05 LCD Display 16*2 1 240 240 

05. Solar Charge 

Controller 

12V 10/20A 1 280 280 

06. Light  1 80 80 

07. Fan AC 220V 1 490 490 

08. Others    1850 

    Total = 5180/= 
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CHAPTER 5 

RESULTS AND DISCUSSION 

 
5.1 Results 

Now, it’s time to talk about the results. 

 
❑ Finally, we have completed our project successfully & check our project its run 

accurately according to our objective. 

❑ At first, we start our system. 

❑ Solar panel will take power from sunlight and save it in battery with help of 

charge controller. 

❑ The DC electricity stored in the battery is converted into alternating current (AC) 

by the inverter. 

❑ The Arduino Nano controls a relay to manage the power supply to connected 

appliances, as lights and fans. 

❑ All data show in LCD Display. 

 
 

Data Table of 15 Days: 

 

Sl. No Date Time Solar Output Voltage 

1. 01-01-24 2 PM 1.6V 

2. 02-01-24 2 PM 1.58V 

3. 03-01-24 2 PM 1.69V 

4. 04-01-24 2 PM 1.2V 

5. 05-01-24 2 PM 1.6V 

6. 06-01-24 2 PM 1.53V 

7. 07-01-24 2 PM 1.04V 

8. 08-01-24 2 PM 1.21V 

9. 09-01-24 2 PM 1.57V 

10. 10-01-24 2 PM 1.6V 

11. 11-01-24 2 PM 1.58V 

12. 12-01-24 2 PM 1.44V 

13. 13-01-24 2 PM 1.67V 
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14. 14-01-24 2 PM 1.6V 

15. 15-01-24 2 PM 1.56V 

 

 

5.2 Advantages 

There are certainly many advantages of our project and some of the major ones have 

been given below: 

⚫ This project reduce human work. 

⚫ Make easy our daily life. 

⚫ This project is easy to use. 

⚫ Cost effective. 

⚫ No foul play takes place. 

⚫ User-friendly. 

⚫ Good way to reduce human energy wastage. 

 
 

5.3 Disadvantages 

 

⚫ Intermittent Power Generation. 

⚫ Initial Cost. 

⚫ Energy Storage Efficiency 

⚫ Battery Lifespan. 

⚫ Maintenance Requirements 

 

5.4 Applications 

This project has applications in many fields due its necessity. We have selected a few of 

them and they are given below: 

 
⚫ It can be used in any educational institutions. 

⚫ It can be used in any industry or corporate offices. 

⚫ It can be used in Hospitals. 

⚫ It can be used to minimize energy wastage. 

⚫ It can be used in residential areas. 

⚫ It can be used in residential areas. 
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5.5 Discussion 

While working on our project, we did face some difficulties as it is a very complex 

system but the end results, we came up with were quite satisfactory. We have put the 

whole system through several tasks to validate our work and also have taken necessary 

notes for future improvements. Some future recommendations that we have involves 

improvement in system design and wiring, adding features for more efficient. 
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CHAPTER 6 

CONCLUSION 

 
6.1 Conclusion 

In conclusion, the Solar Home System (SHS) represents a significant advancement in 

sustainable energy solutions for residential applications. By harnessing solar power and 

intelligently managing its components through the Arduino Nano micro-controller, the 

SHS offers a promising alternative to traditional grid-based electricity. The integration 

of renewable energy, smart control, and user-friendly interfaces contributes to the 

global effort to achieve energy sustainability and mitigate environmental impact. The 

project's design and construction focused on optimizing solar energy harvesting, 

efficient storage, and intelligent distribution, ensuring a reliable and adaptive system. 

The performance study evaluated key metrics, including energy production, battery 

efficiency, system reliability, and user interface functionality. Results indicated the 

system's capability to provide clean and reliable power while adapting to varying 

environmental conditions. 

 
6.2 Future Scope 

As we have already discussed about the limitations of our project so definitely there’s 

room for improvement and thus we have lots of future scope of work available to us for 

this project. Some of these are listed below: 

 
⚫ In future, we are thinking about adding monitor screen to view our  load 

condition. 

⚫ In future we are thinking about adding voice control device to control our 

house load. 

⚫ In future, we are thinking about 100% accuracy. 
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APPENDIX 
 

Micro-Controller Program: 
 

#include <LiquidCrystal_I2C.h> // scl=d1& sda=d2 

LiquidCrystal_I2C lcd(0x27, 16, 2); // I2C address 0x3F, 16 column and 2 rows 

 
 

int solar; 

float input_voltage = 0.0; 

 
 

int battery; 

float input_voltage1 = 0.0; 

 
 

int ledr=2; 

int ledg=3; 

 
void setup() 

{ 

// Debug console 

Serial.begin(115200); 

pinMode(A0,INPUT); 

pinMode(A1,INPUT); 

pinMode(ledr,OUTPUT); 

pinMode(ledg,OUTPUT); 

 

lcd.begin(16,2); 

lcd.init(); // initialize the lcd 

lcd.backlight(); // open the backlight 

} 
 

 

void loop() 

{ 

int analog_value = analogRead(A0); 

input_voltage = (analog_value * 5.0) / 700.0; 
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Serial.print("solar:"); 

Serial.println(input_voltage ); 

lcd.setCursor(0, 0); 

lcd.print("solar:"); 

lcd.print(input_voltage ); 

lcd.print("v"); 

delay(1000); 

 
 

int analog_value1 = analogRead(A1); 

input_voltage1 = (analog_value1 * 5.0) / 800.0; 

Serial.print("Battery:"); 

Serial.println(input_voltage1   ); 

lcd.setCursor(0, 1); 

lcd.print("Battery:"); 

lcd.print(input_voltage1 ); 

lcd.print("v"); 

delay(1000); 

 

if(input_voltage1>5.5){ 

digitalWrite(ledg,HIGH); 

digitalWrite(ledr,LOW); 

} 

if(input_voltage1<5.5){ 

digitalWrite(ledg,LOW); 

digitalWrite(ledr,HIGH); 

} 

} 


